Microsoft Office
Access 2016 for Windows
Introduction to Access
# Table of Contents

Introduction ......................................................................................................................... 4
Learning Objectives .............................................................................................................. 4
The Office 2016 Interface ....................................................................................................... 5
  The Backstage View ........................................................................................................... 5
The Ribbon ............................................................................................................................ 7
Tell Me .................................................................................................................................... 8
  Search for Features ........................................................................................................... 8
  Get Help with Access ....................................................................................................... 8
Creating the Database ........................................................................................................... 10
Creating a Table .................................................................................................................... 11
Things to Remember When Creating a Table ....................................................................... 13
  Primary Key ....................................................................................................................... 13
  Error Traps ......................................................................................................................... 14
  Descriptions ....................................................................................................................... 15
  Adding Fields ...................................................................................................................... 16
  Default Values ................................................................................................................... 18
  Creating a Drop-Down List ............................................................................................... 19
Creating a Table .................................................................................................................... 11
Opening and Closing the Table ............................................................................................. 21
Entering Data into the Table .................................................................................................. 22
Additional Help ..................................................................................................................... 24
Introduction

Microsoft Access 2016 allows people to effectively and efficiently organize data. The various sections presented in this document will help you to build a solid knowledge foundation of the software.

This booklet is the companion document to the Intro to Access 2016 workshop. It includes an introduction to the Microsoft Access 2016 interface, covers the various aspects of database creation and management in Access 2016, and will walk you through the process of creating a simple database in Access 2016.

Learning Objectives

After completing the instructions in this booklet, you will be able to:

- Identify the components of the Access 2016 interface.
- Understand how to use the Tell Me feature.
- Create a new database.
- Understand how to create a table.
- Understand the purpose of the primary key.
- Implement error traps.
- Enter descriptions for fields.
- Understand how to add fields.
- Understand how to enter various types of data into the table.
The Office 2016 Interface

The Backstage View

When first opening Access 2016, the user will be presented with options to open recent documents, start a new blank database, or select from a number of database templates.

To enter the Backstage view after creating your database, click the File tab.

1. To enter the Backstage view after creating your database, click the File tab.
2. The Backstage view will open. From here, you can perform the following actions:
   a. **Info** - Obtain information about your databases (see Figure 3);
   b. **New** - Create new databases and templates (see Figure 3);
   c. **Open** - Open existing databases (see Figure 3);
   d. **Save/Save As** - Save and close databases (see Figure 3);
   e. **Print** - Print and/or preview of your databases (see Figure 3);
   f. **Account** - Access your Microsoft Office 2016 account information (see Figure 3);
   g. **Options** - Access options to change program settings (see Figure 3);
   h. **Help** - Obtain help information on using Access 2016 (see Figure 3); and
   i. **Close** - Close Access 2016 (see Figure 3).

![Figure 3 - Backstage View](image)

3. To leave the Backstage View and return to your document, click the *arrow* button above *Info*.

![Figure 4 - Leave Backstage View](image)
The Ribbon

The Ribbon is a panel that contains groupings of buttons and drop-down lists organized by tabs. Each application in the Office Suite has a different set of tabs that pertain to the functionality of that particular application. Each tab is further divided into groups, such as the Sort & Filter and Find groups.

![Figure 5 - The Ribbon: Sort & Filter and Find Groups](image)

At the bottom right-hand corner of some groups is the Dialog Box Launcher.

Clicking this button opens a dialog box for that group containing further option selections for the group.

![Figure 6 - Dialog Box Launcher](image)

Contextual tabs will appear depending on what you are working on. For example, if you are working in a table, the Table Tools tab appears.

![Figure 7 - Contextual Tab](image)
Tell Me

The Tell Me feature allows you to enter words and phrases related to what you want to do next to quickly access features or actions. It can also be used to look up helpful information related to the topic. It is located on the Menu bar, above the ribbon.

Search for Features

1. Click the Tell Me box.

2. Type the feature you are looking for (See Figure 9).

3. In the Tell Me drop-down, you will receive a list of features based on your search. Click the Feature you were looking for (See Figure 9).

4. You will either be taken to the feature or a dialog box of that feature will open.

Get Help with Access

To receive Microsoft Access Help, either type in the Tell Me box or press the F1 key on the keyboard.

1. Click in the Tell Me box.
2. Type the **question** you want help with (See Figure 11).
3. In the *Tell Me* drop-down, click **Get Help on “question”** (See Figure 11).

![Figure 11 - Get Help on Feature](image1)

4. The *Access 2016 Help* dialog box will appear and display a list of help topics based on your search. Click the **topic** you want help with.

![Figure 12 - Word 2016 Help](image2)
Creating the Database

When you open *Microsoft Access 2016*, you have the option to create a blank database. Using this database, you will be able to create tables, forms and enter data. The following describes how to create a database in *Microsoft Access 2016*.

1. Click on **Blank desktop database**.

![Blank Desktop Database](image13.png)

**Figure 13 - Blank Desktop Database**

2. Enter the **name** of the database in the **File Name** text box.

![File Name Box](image14.png)

**Figure 14 - File Name Box**
3. Click on the Create button. You will be taken to your new database.

![Create Button](image)

**Figure 15 - Create Button**

### Creating a Table

Upon creating a database, it is recommended that you create a table that will house relevant data. The following instructions explain how to create a table within your database.

1. From the Fields tab under Table Tools, click on the View button.

![View Button](image)

**Figure 16 - View Button**

**Note:** Clicking the arrow below the View button will display a drop-down menu with available views.

![Design View](image)

**Figure 17 - Design View**
2. The *Save As* window will open, prompting you to name your table. Enter the **name** of the table that you are about to create under *Table Name*.

![Figure 18 - Table Name](image)

3. Click **Ok**.
4. The *Design view* will open and display the **Field Names** and **Data Types** for the current table. Enter in the appropriate **Field Names** and **Data Types** (e.g. First name, Last name, etc.). The following explains the different data types that could be used for the table:
   a. **AutoNumber** - The database will create a unique number for each record that is entered (See Figure 19).
   b. **Short Text** - Use for fields that contain letters and numbers. This option can contain up to 255 characters (See Figure 19).
   c. **Long Text** - Use for fields requiring long entries. Both letters and numbers can be created in this field. This option can hold up to 65,536 characters (See Figure 19).
   d. **Number** - Used when calculable numbers will be required for the field (See Figure 19).
   e. **Date/Time** - Select this choice when you need to enter a date or time (See Figure 19).
   f. **Currency** - Used when currency needs to be entered into the field (See Figure 19).
   g. **Yes/No** - Used when the field requires a yes or no entry. Appears as a check-box in the *Datasheet* (See Figure 19).
   h. **OLE Object** - Allows for the embedding and linking of a number of supported file types (e.g. *PDF*, *Microsoft PowerPoint*, *Microsoft Excel*, *Microsoft Word*, and *Visio* documents, and image and sound clips) (See Figure 19).
   i. **Hyperlink** - Use when email addresses and hyperlinks are required (See Figure 19).
   j. **Attachment** - This option allows the user to attach one or more files to the record (See Figure 19).
   k. **Lookup** *(not displayed)* - This option helps the user create a drop-down list for the field. When this option is selected, the *Lookup Wizard* will begin (See Figure 19).

![Figure 19 - Field Names and Data Types](image)
Things to Remember When Creating a Table

It is important to remember the following when creating a table.

Primary Key

Records in Access can be organized by a unique, identifying number. The primary key is used to ensure that no two records have the same number. For example, in the table created for student information, it is important that each student has a unique Student ID.

![Figure 20 - Primary Key Field](image)

The primary key can be used with the following data types: *Auto Number, Number, and Text*.

The primary key can be toggled on/off by clicking on the **Primary Key** button located on the **Design** tab.

![Figure 21 - Primary Key Button](image)

When the **Primary Key** is active, it will appear as a key icon to the left of the field name.

![Figure 22 - Primary Key Icon](image)
Error Traps

Error traps help to make certain that correct data is entered into the database by users. With an error trap, we can have an error message appear in the event that incorrect data is entered. For example, for the field Campus, perhaps the only two campuses that should be entered are East and West Campus. The following explains how to create an error trap for this field.

1. Click to select the field Campus.

![Figure 23 - Selecting the Field](image)

2. Click Validation Rule, located under the Field Properties section.

![Figure 24 - Validation Rule](image)

3. To make certain that the user enters only West Campus or East Campus, enter the following: “West Campus” or “East Campus”.

![Figure 25 - Entering the Validation Rule](image)

**Note:** If you were working with numbers, you could also enter a formula to make certain that only a specific range of numbers are entered. For example, if you wanted to make sure that only numbers from 0 to 100 are entered, you would enter the following: \( \geq 0 \) and \( \leq 100 \).
4. Select **Validation Text**.

![Figure 26 - Validation Text](image)

5. Whatever appears in the **Validation Text** field is the message that will appear if a user attempts to enter data that violates the **Validation Rule** that was entered in Step 3. For example, the following is an example of a message that could be entered: **Invalid Entry! Please enter one of the following campuses: West Campus or East Campus.**

![Figure 27 - Validation Text String](image)

**Descriptions**

The **Description** column is a place where you can provide instructions to users who will be entering data into the table.

![Figure 28 - Description Field](image)
The following explains how to create a description for a field.

1. Place your cursor in the Description column next to the field of your choice (See Figure 29).
2. Enter a description (See Figure 29).

![Figure 29 - Enter a Description](image)

### Adding Fields

Once the table has been completed for the database, it is possible to add fields to the datasheet. The following explains how to add a new field for Expected Graduation Date between Application Received and Account Balance Due.

![Figure 30 - Adding a field](image)

1. Right-click on the Account Balance Due field.

![Figure 31 - Right Click on the Desired Field](image)
2. A context sensitive menu will appear. Click **Insert Rows**.

![Figure 32 - Insert Rows](image)

**Note:** If you wish to delete a field, click **Delete Rows**.

3. A new row will be inserted between Application Received and Account Balance Due. Type **Expected Graduation Date** into the field.

![Figure 33 - New Row](image)

4. Next to Expected Graduation Date in the Data Type drop-down, select **Date/Time**.

![Figure 34 - Date/Time](image)
Default Values
As the database designer, you have the option of including Default Values. For example, in the table below, suppose that 75% of the entries for Campus will be East Campus. You could include a default value of East Campus to make data entry easier for the user.

The following explains how to include the default value of East Campus for Campus.

1. Select the Campus field.

2. In the Field Properties, click the Default Value field.

3. Enter the Default Value that you wish to appear in the Default Value field. In this case, we will enter East Campus.

4. When the user creates a new record, East Campus will appear as a default for the field Campus. This will make data entry easier. However, another value can be entered for Campus, if desired. For example, West Campus could be entered in place of East Campus.
Creating a Drop-Down List

A drop-down list can make the job of the data entry person easier. When a drop-down list is available, the user simply clicks the list and selects the option of his or her choice.

For example, we can set a drop-down list for Hometown if there only a certain number of cities that are to be selected. If the cities for the Hometown field were Atlanta, Kennesaw, and Macon, the user would simply click the list and select the city from the drop-down menu. This eliminates a lot of typing for the user.

The following steps explain how to create a drop-down list for the field Hometown.

1. Next to the Hometown field, click the drop-down arrow.

![Figure 38 - Select the down-arrow]

2. From the drop-down menu, click Lookup Wizard.

![Figure 39 - Lookup Wizard]
3. The *Lookup Wizard* window will appear. Click *I will type in the values that I want*.

![Figure 40 - Lookup Wizard: Select I will type in the values I want](image)

4. Click the **Next** button.
5. Under *Column 1*, type the **values** that you want to appear.

![Figure 41 - Type the values you want to appear](image)

6. Click **Next**.
7. Click **Finish**.
Opening and Closing the Table

When you are finished creating the table, it can be closed by clicking the X in the upper-right corner of the table.

![Figure 42 - Clicking X to Close the Table](image)

To open the table again, double-click the name of the table that you want to open. The name of the table will appear on the left area of the window.

![Figure 43 - Re-opening the Table](image)
Entering Data into the Table

Opening a table will display the *Datasheet* view. Once open, you can begin entering data into the table. The following explains how to enter data into your table:

1. **Click on the first blank cell.**

2. **Begin typing your data into the cell.** When finished typing your data into the cell, press the **Tab** key on your keyboard to move right to the next cell.

3. **Continue entering data into the cells.**

**Note:** For cells that have *Default Values*, you will see data pre-populate the cell. You may leave the data as is or enter different data as needed.

4. **For cells that use a *Lookup Value* data type:**
   - **Click on the appropriate cell.** A dropdown arrow will appear.

5. **Click the dropdown arrow.**
6. Select the appropriate **Lookup Value**.

![Figure 48 - Select the Lookup Value](image)

For cells that use the *Date/Time* data type:

7. Click on the **appropriate cell**. The *Calendar icon* will appear next to the cell.

![Figure 49 - Calendar Icon](image)

8. Click the **Calendar icon**.

![Figure 50 – Accessing the Calendar](image)

9. The *Calendar* will appear. Select the appropriate **date** or manually **type** the date into the cell.

![Figure 51 - Select a Date from the Calendar](image)
For cells that use the Yes/No data type:

10. Click on the checkbox to indicate the yes/no value. A checked box indicates a Yes value. An un-checked box indicates a No value.

![Figure 52 - Yes/No](image)

For cells that use the Currency data type:

11. Simply enter the value. Your number will automatically be entered as currency.

![Figure 53 – Currency](image)

**Additional Help**

For additional support, please contact the KSU Service Desk:

**KSU Service Desk for Faculty & Staff**
- Phone: 470-578-6999
- Email: service@kennesaw.edu
- Website: http://uits.kennesaw.edu

**KSU Student Helpdesk**
- Phone: 470-578-3555
- Email: studenthelpdesk@kennesaw.edu
- Website: http://uits.kennesaw.edu